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Pop in and have a cuppa in 
the learning centre. You 

can get answers to computer 
problems, ask questions and get 
advice. If you need to bring in 
your computer please ring:

03 365 1979 
and leave a message

Items that can be solved quickly 
will be $5 but problems requiring 
significant time will attract up to 
$20 workshop charge.

The SeniorNet Mac Apple NEWS 
is distributed bimonthly on 10th 
April, June, August, October, 
December and February. You 
will be kept updated on important 
matters  with a Mini Newsletter 
by email every week, in between 
times.

Morning Sessions
MONDAY, WEDNESDAY,

 and FRIDAY 10.00 am to 12 Noon

I do hope you all like the new look of your Apple News 
please let us know your thoughts .You can email me 

at: president@seniormac.org.nz.
We would also like to know what Workshops, Courses 
and Catch sessions you want us to hold, we do need 
your input and now is the time to tell us what your 
thoughts are. We can’t do these things for you if we 
don't know what you want. Send me your ideas to  
president@seniormac.org.nz. I want lots of ideas from you all as I want to see my 
new email on our new portal full of lots of ideas.
I have had great feed back about my weekly news that we send out. This will keep 
you all informed with what is happening and give you useful information that people 
have been sending to me.If you have any useful info that you think other members 
might like to know send that to me as well. I think it is very important that you 
all know what is going on in SeniorNetMac and this is one way we can keep you 
informed. Winter is on the way and I will have to stay inside so I will need something 
keep me busy so send me emails.  Thanks in anticipation.        � 

                 iTunes is put to rest

The replacement for iTunes will be three separate apps for Music, 
Podcasts and TV and won’t mean your music will have disappeared. It 
will be in the Music App.  Meanwhile, iPhone synching has moved to 
Finder.
macOS Catalina also means the Mac gets the iPhone’s Screen Time 
feature, family sharing, some of the Message Apps features and Siri 
shortcuts.

Breaking News
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Deadline for August/September Apple NEWS

July 28th
Please have your copy for the next Apple NEWS to me 
by the above date.
Copy can be either typed straight into an email, as a 
Word file or as Rich Text Format.
Digital images need to be at least 220dpi  or higher 
(72dpi will not reproduce well)
Please no hard returns except at the end of a 
paragraph.

Hi there.
Welcome to the first edition of 
Apple NEWS. This now replaces 
the Infoletter and will still be   
published bimonthly.
Winter is now upon us and the 
temperatures are dropping, we 
have had a splendid Autumn 
and we can now look forward to 

(hopefully) a perfect Spring in a few months time.
In this issue we have featured Knitted Knots, Members 
Photo Corner, Spams Scams and Unwanted Phone Calls, 3 
Tips from Pam Doughty, and 2 Tips from Brian the Pirate.
The Black Caps have had 3 Wins in the Cricket World Cup, 
the wheels fell of the Crusaders bus in Fiji, (but they bounced 
back with a whammy against the Rebels) the Budget was 
delivered despite a lot of hoo 
ha pre announcement. The TV 
programmes get worse—thank 
goodness for Netflix, and Neon 
etc.  Brexit seems still to be a 
"can of worms". Global Warming 
is  becoming more and more  
frightening and certain powerful 
people are still in denial.    �

Welcome to New Members
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No liability is accepted for any errors or omissions or inadvertent disclosure not meant for publication. Any opinions 
expressed may not necessarily reflect the views of the Editor or SeniorNet Mac Inc. who, likewise, neither endorse nor 
accept responsibility for products or services of any advertisers or for opinions expressed within the Apple NEWS.

Every effort has been made to ensure that no known copyright issues have been breached and 
that appropriate acknowledgements have been made, with regard to all articles and advice 
given in this publication.

Disclaimer

APPLE USER GROUP               Cookin’ with
Canterbury Apple Users 

is a subgroup of Christchurch SeniorNet Mac Inc. and 
meets on the last Wednesday of each month at the 
SeniorNet Mac Rooms, 41 Essex Street, Christchurch.  A 
heated room with all conveniences, tea/coffee and bikkies. 
FREE to SNM members. General public $4.00
It has its own web site called www.appleusers.co.nz The 
free HELP email list is open to all Mac users who wish to 
give or receive assistance. See on the website under ‘email 
list’ for instructions on how to subscribe or unsubscribe to 
this service.    �

Our Sponsors

Also in association with:
The Federation of NZ SeniorNet Societies

Community Organised 
Grants Scheme

WANTED

•	Web Advertising on our Web Site
•	Apple NEWS Advertising
•	Reasonable Rates: For prices contact:

Customer Services
03 365 1979

services@seniormac.org.nz

Advertisers Our Direct banking number is 020816-0376043-00

PLEASE when paying monies to SeniorNet Mac, 
include as reference either your Name 

or Membership Card number.
We are receiving credits from time to time from 
unknown members.
We have no way of telling who they are from.
Your Membership card has a unique number and 
should begin with the figure 4

Elizabeth Chesney
Treasurer@seniormac.org.nz

IMPORTANT

INTERNET  BANKING

GERMAN APPLE TART
Take 2lbs. apples, ¼ lb. stoned dates, 2 tablespoons 
sugar, 1 tablespoon butter, 1 teaspoon ground cinnamon, 
1 teaspoon ground ginger. For the paste: ½lb. flour, 1 
ounce sugar 1 teaspoon cinnamon, 1 teaspoon baking 
powder, ¼lb of butter, 1 egg yoke, 2 tablespoons of milk.
Stew together until soft the apples peeled and cored, 
dates, sugar, butter, cinnamon and ginger. Beat up 
and put on a dish to cool. Make a paste of the flour, 
sugar, cinnamon, baking powder, and butter rubbed 
in; mix with yoke of egg and milk. Roll out, line a 
deep plate, putting a double piece round the edge, 
ornament, fill with apple mixture, and bake for  ½ 
hour. Beat white of egg stiff, sweeten, spread over 
and brown in the oven.      �

APPLE POP
Slice apples to fill a large jar ¾ full; to this add a 
heaped cup of sugar and fill with boiling water. 
Add compressed yeast, 1 square inch in size , 
when luke warm. Let this stand for 3 or 4 days, 
strain and bottle. Tie corks down  firmly. Ready 
for use in a few days.     �
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Knitted 
Knots

Elizabeth Chesney was the 

Guest Speaker at the March 

Social and Luncheon.

Due to lack of space in the 

April/May Infoletter we were 

unable to feature some of her 

knitted designs, so we feature 

some of them here in the 

June/July Apple NEWS.
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Photo CornerMembers

Lake Tekapo—Mhairi Erber

Marching to Infinity—Joe Adams

This is an image (probably Miners' or Workmen's huts on the West Coast) and was restored 
by Barbara Blowes from one of her father's 35mm slides which had mould on both sides and 
after cleaning the mould off was restored using Photoshop.
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Spams, Scams 
& 

Unwanted 
Phone Calls

1. Don’t give anyone your password—banks or any other institutions will 
never ask for it. 
2. Banks and other organisations will never send you any email asking you 
to "Verify" your account. Just delete emails like this. 
3. Microsoft, or any other electronic or computer company will not ring 
you to say that your computer is not working correctly—hang up. If you 
are having issues, take it to a local repairer. 
4. Spark Vodafone etc. will not ring you saying you have issues you have 
to sort out, or that you will lose their service the next day. Do not push 1 
for.. hang up. 
5. Never give out your Credit Card details to anyone who rings you, just 
hang up. 
6. Many of the on-line scams will use legitimate company logos such as 
New World, Caltex—ring your local store or garage to check if they are 
running a promotion. 
7. While you may be the most desirable person in Canterbury, do not 
succumb to the charms of a 25 year old from overseas—they usually don’t 
exist and the scammers want your money!! 
8. On-line shopping, again check that the `shop’ actually exists before 
sending money. 
9. If you receive calls on your answerphone, or call identification machine 
which you do not recognise, especially long overseas numbers, don’t call 
them, it may be a very expensive call. If you are unsure of whether or not 
it may be someone you know, either contact them from your Contacts, or 
wait for them to call you back.   �

Do's and Don'ts

Today most Internet Providers have a 
reliable Spam Screen—but still the 
odd spam sneaks through! Recently I 
received an interesting example in my 
Inbox. (see below) Aha! I thought—as 
I have never used Vodafone on any of 
my devices! As you can see  no logo, 
just the word vodafone at the top, 
very politely worded message—but 
checkout the link and the spelling of 
vodaafone. So after taking a screen 
shot I sent the email to trash. Heard 
no more! When we moved to the 
Kapiti Coast 4½ years ago we decided 
to have an unlisted Landline No. to do 
away with those pesky calls during 
our Dinner hour! Wanting us to take 
part in surveys, buy Aluminium joinery 
etc. Peace and quiet for 3 years until about 18 months ago when we suddenly started to get calls with this number showing 
on our Caller ID, 00612844544308. If you pickup the handset and say "Hello" the silence is deafening. So we hang up, now 
when we see that number we pick the handset up and put it straight back in the cradle. How they can call an unlisted 
number I do not know. —Editor     �

“A love letter lost in the mail, forgotten, miss delivered and then discovered years later and 
received by the intended is romantic. A love letter ending up in someone's spam filter is just 
annoying.” —B.J. Neblett
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Tech Tip
Tips from Pam Doughty
courtesy AUSOM News, March/April 20193

Working with ‘Bullet Points’ in 
Pages
Pages for the Mac
There are many, many ways of formatting text that in-
cludes a series of ‘bullet points’. This article is aiming 
to produce the following:

This CAN be done using the following steps using 
Pages on your Mac.
Type the First Line.
Before typing the first bullet point select Bullet from 
the drop-down option beside Bullets & Lists in the 
Format
side-bar. 
Type your first bullet point.
Press Return and Type your Second bullet point.
Press Return and Type your Third bullet point.
Press Return then press Return again and you will be 
ready to type your last sentence.

TRY IT.

Possible complication
It may be necessary to have more than one paragraph 
within a single bullet point. BUT pressing ‘return’ 
results in a new bullet point. To obtain a new line 
without the bullet point press shift-return.
If we wanted to add an additional paragraph after the 
Second bullet point move the cursor to the end of the 
bullet point and press shift-return. A new paragraph 
without a bullet point in front of it will start directly 
below the S of ‘Second bullet...’.

Pages on the iPad
When working with Pages on the iPad I create the origi-
nal example in exactly the same way as on my Mac.

First sentence or paragraph with no bullets.
• First bullet point.
• Second bullet point.
• Third bullet point.
Last sentence or paragraph with no bullets.

The difference comes when I want a second paragraph 
within a bullet point. Using the on-screen keyboard 
I cannot use shift-return. The trick is to locate ‘Line 
Break’ by tapping ¶ as shown in the next image.    �

Shift-Return Keynote — iOS
In Keynote tap and hold where you want to enter a 
Line Break and select Insert to obtain the following:

BONUS TIP: To add a Line Break within a cell in 
Numbers or when entering text in Pages on an 
iPhone tap-and-hold and select Insert from the 
black bar.    �
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Keep Individual Pages from a 
PDF — macOS
This article shows how you might select pages from a PDF 
like AUSOM News, save it as a stand-alone file named 
appropriately and saved in an appropriate folder. Towards 
the end of the article a solution to ‘how do I save just part 
of a page?’ is explored.

To copy pages from a PDF and keep them as
individual files:
Open the PDF document in Preview and Select View > 
Thumbnails.
Move your Preview window so you can see your Desktop.
Drag the thumbnail of the page you want to keep onto your 
Desktop.

The dark-grey area above is the Desktop — page 1 is being 
dragged onto the Desktop
Click on the Desktop so you can rename the file you just 
‘dragged’ and move it to a suitable folder.
NOTE: The page stays in the original PDF and a new file 
will appear on your desktop named filename (dragged).
PDF. Result: your original PDF file is retained and a copy 
of the page you want to keep is now filed where you can 
locate it.

Check that the PDF created will open and display correctly 
in Preview. Some PDF files do not allow ‘dragged’ pages. 
You may need to follow the procedure explained below.

A second way to create a new PDF with a 
page from an existing PDF

First page 26 is selected in the View sidebar (its 
page number is highlighted), then Edit >Copy is 
selected
• Select one or more thumbnails in the sidebar, and
• Press Command+C (or Edit > Copy).
This stores the page(s) in the clipboard. Choosing File > 
New from Clipboard creates a new Untitled PDF document 
within Preview containing the information on the original 
page(s).
Save the Untitled PDF in an appropriate folder as 
before. 

Saving a copy of just part of a page
The second procedure is the one to use if you want to save 
just part of a page.

With the PDF open in Preview display the Markup toolbar 
and select the crop tool (circled near top-left in the next 
image).
Drag over the part of the page you wish to keep.
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[An Aside: Once part of the page is outlined (selected) a 
‘Crop’ button will appear in the Markup bar. Clicking ‘Crop’ 
will hide the remainder of the page. NOT the option we 
want to make use of here.]
To retain the selection as an individual page:
• Press Command+C (or Edit > Copy) to store the selection 
on the clipboard.
•File > New from Clipboard will display a new Untitled PDF 
containing the information that was selected. This file can 
be saved and named appropriately.

Ross Clendon               

Combating Poverty in Asia.
Ross was born and raised in Lower Hutt. He studied history and law at university here in New 
Zealand (Otago and Victoria), following that with three years at Cornell University in the United 
States on a Fulbright Scholarship. After practising as a lawyer in London and Wellington, 
Ross left New Zealand in his mid-30s with his family to take up a position with the Asian 
Development Bank, a multilateral finance institution headquartered in Manila, Philippines. New 
Zealand is one of the ADB’s 68 member countries. Ross became principal counsel in the ADB’s 
legal office before returning to New Zealand 20 years later in 2006.  His talk will discuss the 
role played by the ADB in the developing countries of Asia and the Pacific, and some of his own 
experiences as an expat living and working in Asia.    �

GUEST 
SPEAKERS

25 June

Ross Clendon

Bronwyn Groot, 
Fraud Education Manager, Commission of Financial Capabilities (CFFC), Auckland

“Get Savvy on Scams”
If you are ever in the unfortunate position of being caught out in a fraud or a scam, Fraud 
Education Manager, Bronwyn Groot, is the person you want batting in your corner. She‘s a 
subject matter expert on frauds and scams – with multiple awards to back it up. Bronwyn 
has 20 plus years in the banking industry, including seven working in Financial Crime & 
Security. She has lots of great stories! When she’s not fighting fraudsters and helping their 
victims, Bronwyn enjoys spending time with her family and friends.    �

30July

Bronwyn Groot

Acknowledgement
The information provided here was originally published
in “An Introduction to Preview” by Pam Doughty.
The original publication can be downloaded from https://
ausom.net.au/pams-page/ as an iBook.
iBooks are suitable for reading using Books on an iPad/
iPhone (called iBooks prior to iOS12) or on a Mac (called 
iBooks prior to Mojave) using Mavericks or better.   �

Everybody is a genius. But if you judge a fish by its ability to climb 
a tree, it will live its whole life believing that it is stupid.

—Albert Einstein



Page 11Helping Seniors with Apple Technology  http://seniormac.org.nz

SeniorNet Mac  Social &
Luncheons

30 April

Raffle Results 
30 April

Grace Adams
Bill Peirson

Jillian Wilson

‘Why I Love working at The Court’
This address by Roanna Dalziel was captivating; entertaining, interesting, 
compelling, and somehow inspiring and intriguing, all at the same time.
Roanna captured everyone’s attention with her polished delivery, but it went 
deeper than just that. Somehow you knew that if she was dealing with you 
directly, you’d feel as though you mattered, and that she cared.
As the Literary Manager at the Court Theatre Roanna is in charge of choosing 
and developing plays, and reading and writing scripts, all with relish and 
trepidation.
For Roanna it’s all about Christchurch art, about the whanau, our community. She 
loves the Court intimacy and what it can be for every individual.
After the 2011 earthquakes The Court had to shift, after having endured the 
trauma that was common to many in Christchurch. They were overwhelmingly 

thankful that the stone wall didn’t shift more than it did. 
They were lucky to find The Shed, and in December 10 
2011, they reopened. And People Turned Up.
The play-writer’s job is to get the compelling story onto 
paper, and the actors’ job is to get the vibrancy and 
impetus off the paper.  Roanna always wants people to 
be proud as punch about what happens and she talked 
about being transformed by the community (I thought that 
she was a transformer herself). 
It’s all about being inclusive, belonging, friendship – 
through art, celebrating being human. Art as respite. Art 
as challenging and celebrating what it is to be human; 
what it is to be from Christchurch, of Christchurch and for 
Christchurch.
By the way – the Court’s phone no. is 03 963 0870. It’s 
important!    �

Roanna Dalziel

Roanne during her presentation
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SeniorNet Mac  Social &
Luncheons

There was a very good attendance for this social and lecture. After 
lunch at the Cashmere Club, we were addressed by Rita Noetzel, 
Programme Director and Team Co-ordinator of the Clown Doctors in 
New Zealand, who introduced us to the worldwide activities of Clown 
Doctors, undertaken by particular organizations in different countries. 
The presentation began with a short video and the subsequent talk was 
illustrated by a series of instructive slides.
Clown Doctors, who are not doctors, but are not social work volunteers 
either, are professional entertainers whose task is to use their skills to 
improve the lot of hospital patients, in particular, but not exclusively, 
children and older persons, by eliciting laughter, that most traditional, 
and proverbially the best of medicines, through comic performance. 
The best-known adjunct of clowning, the red nose, is employed as their 
symbol, and instantly characterises the clown wearing it as a non-
threatening person without status in the hospital, who will therefore not 
bear bad news, or give unwelcome orders.
All clown doctors undergo a training course which of course does 
include basic medicine and instruction on the nature of the hospital 
environment but performances by individuals or groups of clown doctors 
are entirely their own. A minimum team of two clown doctors ensures 
no patient can ever be alone with a stranger, however humorous; also, 
two allows for interaction between clowns as well as with the patient. 
There are written guidelines and a Code of Ethics.
Of especial interest were the comments made in the video or reported 
on a slide of patients expressing gratitude for the clown doctors’ visit. 
These included older adults as well as children. In one story, the most 
intractable type of patient, a fourteen-year old boy, apparently did not 
stop using his iPad during the clown doctor’s visit but was observed to 
be laughing as the act concluded. Clown Doctors do make reports on 
their visits, allowing success to be judged.
During question time, the speaker described the financing of clown doctor 
activities, mentioning that at present hospitals themselves do not contribute. 
She also noted that her talk to us was just one way to publicise clown 
doctors, observing that third-year medical students were also one of the 
audiences, permitting future doctors to be more familiar with this therapy.

28 May
Rita Noetzel, 
Programme Director & Team Co-Ordinator: of The Clown Doctors
“Humour for Health”

1st  Brian Henderson
2nd Andrew Grant
3rd Margaret Grant

Raffle Results 
28 May

Photos courtesy
www.clowndoctors.org.nz
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 Courses & Workshops




COURSE DESCRIPTION 

          Mac Basic 2               Using important apps their setup/ customisation

          iPad Basic                  Basic Operations for iPad users

          iPhone  Basic             Basic operations for iPhone users

          iPad/iPhone Apps      Operations for iPad /iPhone users

          Email, Calendar          Learning to make the most from email, calendar

          Notes                          Simple word processing, getting ready for xmas letters

JULY

 iPad Basic 2 weeks 1st July 8th July Monday 2 - 4 pm

iPhone Basic 2 weeks 2nd July 9th July Tuesday 10 -12 noon

Email, Calendar 2 weeks 3rd July 10th July Wednesday 2 - 4 pm

Mac Basic 2
2 weeks 9th July 16th July Tuesday 2 - 4 pm

iPad/iPhone Apps 2 weeks 22nd July 29th July Monday 2 - 4 pm

Notes 2 weeks 24th July 31st July Wednesday 2 - 4 pm

                                      COURSES and WORKSHOPS 
                                                   JULY/AUGUST 
                 4 Week Course           $5 pre hour             2 Week Course $5 pre hour 

                 Workshops                 $5 pre hour   	  One on One $20 pre hour

                 Catch Session            $5 pre hour


All courses must be paid before the course starts. Held at the SeniorNet rooms.


                                        WORKSHOP  DESCRIPTION 
                 Contact for iPad,                      Learning to make the most from  Contacts,
                 Skype/Facebook                      Basic video-conference applications                                                                                                                                                                                                                                  
                 iPad/iPhone Introduction         A basic introduction to the iPad/iPhone

WORKSHOPS

iPad/iPhone Introduction 15th July   Tuesday 2 - 4pm

Skype/Facebook 16th July                 Tuesday 10 - 12 noon

Contacts for iPad, 17th July                   Wednesday 2 - 4pm

JULY



Page 14Helping Seniors with Apple Technology  http://seniormac.org.nz

 Courses & Workshops

	 	 

        

                   
                    

AUGUST
iPhone Basic 2 weeks 6th August 13th August Tuesday 2-4 pm

Mac Basic 1 2 weeks 7th August 14th August Wednesday 2-4 pm

iPad Basic 2 weeks 8th August 15th August Thursday 2-4 pm

iPad/iPhone Apps 2 weeks 22th August 29th August Thursday 2-4 pm

COURSE DESCRIPTION 
          Mac Basic 1               Introduction to Mac, Finder, Dock & running applications

          iPhone Basic              Basic Operations for iPhone users

          iPad Basic                  Basic Operations for iPad user

          iPad/iPhone App        Operations for iPad/ iPhone user only


                                   WORKSHOP  DESCRIPTION 
               iCloud and Dropbox               What are these and how to use them
               iPad/iPhone Introduction        A basic introduction to the iPad/iPhone
               Simpleprints                           Great way to put photos into a book

WORKSHOPS

iCloud and Dropbox 5th August                          Monday 2 -4 pm

iPad/iPhone Introduction 13th August                       Tuesday 10-12 noon

Simpleprints 20h August          Tuesday 10-12 noon

 All of the above Courses,Workshops, Contact: 
Club Rooms = Phone 03 3651979 and leave a message. We will contact you as soon as 
possible. 
Members with iPad and iPhones must have taken an iPad/iPhone introductory 
workshop before allowed to take any  other course relative to their device.                    

AUGUST

                        

AUGUST

iPhone Basic 2 weeks 6th August 13th August Tuesday 2-4 pm

Mac Basic 1 2 weeks 7th August 14th August Wednesday 2-4 pm

iPad Basic 2 weeks 8th August 15th August Thursday 2-4 pm

iPad/iPhone Apps 2 weeks 22th August 29th August Thursday 2-4 pm

WORKSHOPS

 iCloud and Dropbox

 iPad/IPhone Introduction

 Simple Prints

 5th August

 13th August

 20th August

 Monday

 Tuesday

 Tuesday

 2-4 pm

 10-12 noon

 10-12 noon

For all of the above Courses,Workshops, Contact: bookings@seniormac.org.nz

or Phone 03 3651979 and leave a message. We will contact you as soon as 
possible.

Members with iPad and iPhones must take an iPad/iPhone introductory 
workshop before taking any other course relative to their device.                    
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Brian the Pirate’s Tips

Tip #1

Learn Mac OS X ShortcutsLearn Mac OS X Shortcuts 
If you have a desktop or laptop computer, then you may be interested in becoming 
more proficient in using some of the shortcuts for a number of keyboard actions. 
These shortcuts are universal and work with the majority of applications. 

!  - l  (L)    Make alias 

!  - Option - drag  Make alias in new location 

!  - r       Find original of the alias 

!  - shift -n   New folder 

!  - click in Finder window    Menu (new folder / info) 

!  - n       New Finder window  (home) 

!  - t       Add to favourites 

!  - m    Minimise window 

!  - option - m   Minimise all windows 

!  - right arrow   Expand folder listing 

!  - left arrow   Collapse folder listing 

!  - option -w   Close all open windows 

!  - w    Close all open windows 

!  - up arrow   Show parent folder (up one level) 

!  - shift - option - delete Empty Trash immediately 

!  - 1       View as icons 

!  - 2       View as list 

!  - 3       View as columns 

!  - option - d   Show or hide Dock 

!  - shift - 3   Grab screen file (picture) 

!  - shift - 4   Grab area to file (picture) 

!  - shift - 4, spacebar Grab window to file 

!  - shift - control - 4    Grab selection to clipboard 

!  - option - eject  Sleep �
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SeniorNet Mac Inc. Rooms and Learning Centre
41 Essex Street, Christchurch

Brian the Pirate’s Tips

Websites & Helpful Hints
Canterbury Apple Users
Applebyte (online web version)
http://www.appleusers.co.nz/

Welcome to the Apple Macintosh User's Learning Centre - 
SeniorNet Mac Incorporated
Apple NEWS (email/online download)
http://seniormac.org.nz

SeniorNet
Gizmoe (email)
https://seniornet.co.nz/

The Official NIST US Time
https://www.time.gov/ie/

Live stream: 1 News at Midday
https://www.tvnz.co.nz/one-news/new-zealand/live-
stream-1-news-midday-v2.html?variant=tb_v_4

XE Currency Converter - Live Rates
https://www.xe.com/currencyconverter/

Webster in The Oldie - Webster's latest thought
http://www.askwebster.co.uk/

U3A Network Canterbury
https://www.u3anetcant.nz/

Tip #2

Time and Date
www.timeanddate.com

Doctor price comparison NZ | Find the cheapest doctor | 
DoctorPricer https://doctorpricer.co.nz/

Price Comparison | Find the best deals on PriceSpy NZ
www.pricespy.co.nz

Petrol Spy - Fuel Prices & Fuel Watch in Australia
https://petrolspy.com.au

Cheap flights, Hotels and Rental cars | Dohop.com
www.dohop.com

Lightning & Thunderstorms - New Zealand
http://en.blitzortung.org/live_lightning_maps.php?map=21

Broadband Compare – The Best Broadband Deals in NZ – 
Save Now
https://consumer.broadbandcompare.co.nz/

Can you get better broadband right now? | Chorus
https://www.chorus.co.nz/

AlternativeTo - Crowdsourced software recommendations
https://alternativeto.net/
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